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Bedienungsanleitung

Vielen Dank für Ihre Entscheidung zu diesem Gerät.

Bitte lesen Sie sich diese Bedienungsanleitung vollständig durch, um beim Einsatz dieses Geräts alles richtig zu ma-
chen. Bewahren Sie die Anleitung danach an einem sicheren Ort auf.
Jegliche Form der nicht schriftlich genehmigten Vervielfältigung dieser Bedienungsanleitung ist verboten.
Änderungen der technischen Daten und Produktmerkmale ohne Vorankündigung vorbehalten.
Die in dieser Anleitung erwähnten Bedienschritte sollten eigentlich richtig sein und sind auch nachgeprüft worden. 
Wenn trotzdem etwas unrichtig ist, verständigen Sie uns bitte.
Roland DG haftet weder für direkte, noch indirekte Schäden bzw. Verdienstausfall, die/der sich aus der Verwendung 
dieses Geräts oder der nicht erbrachten Leistung ergeben könnten.
Roland DG haftet weder für direkte, noch indirekte Schäden bzw. Verdienstausfall, die/der sich aus der Verwendung 
der mit diesem Gerät gefertigten Objekte ergeben könnten.

Roland DG CORPORATION
1-6-4 Shinmiyakoda, Hamamatsu-shi, Shizuoka-ken, JAPAN 431-2103
MODELLBEZEICHNUNG: Siehe die Angaben auf dem Typenschild.
ZUTREFFENDE RICHTLINIE: EG-RICHTLINIE FÜR NIEDRIGSPANNUNG (73/23/EEC), EG-RICHTLINIE FÜR ELEK-
TROMAGNETISCHE KOMPATIBILITÄT (89/336/EEC)
VORSICHT: Hierbei handelt es sich um ein Gerät der Klasse “A”. Bei Heimgebrauch könnte es den Radio- oder Fernsehemp-
fang stören. Bitte treffen Sie dann die erforderlichen Maßnahmen.

CutStudio ist ein Warenzeichen der Roland DG Corp.
Windows® ist in den USA und/oder anderen Ländern ein eingetragenes Warenzeichen der Microsoft® Corporation.
Macintosh und Mac OS sind in den USA und anderen Ländern eingetragene Warenzeichen oder Warenzeichen der Apple Computer, Inc.
Adobe und Adobe Illustrator sind in den USA und anderen Ländern eingetragene Warenzeichen oder Warenzeichen der Adobe Systems Incorpo-
rated.
Corel und CorelDRAW sind eingetragene Warenzeichen oder Warenzeichen der Corel Corporation bzw. Corel Corporation Limited.
Alle anderen erwähnten Firmennamen und Produktbezeichnungen sind Warenzeichen oder eingetragene Warenzeichen der betreffenden Eigentü-
mer.
Copyright ©2005 Roland DG Corporation
http://www.rolanddg.com/
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Bitte lesen Sie sich diese Vereinbarung sorgfältig durch, bevor Sie die versiegelte Verpackung der CD-ROM öffnen 
Durch das Öffnen der versiegelten Verpackung erklären Sie Ihr Einverständnis mit den Bedingungen und Bestim-
mungen dieser Vereinbarung.
Roland DG Corporation (“Roland”) gewährt Ihnen das nicht übertragbare und nicht exklusive Recht, die in diesem 
Paket enthaltenen COMPUTERPROGRAMME (“Software”) den folgenden Bedingungen und Bestimmungen ent-
sprechend zu nutzen.

1. Beginn
Diese Vereinbarung tritt mit dem Kauf und dem Öffnen der versiegelten CD-ROM in Kraft. Als Beginn dieser Ver-
einbarung gilt der Tag, an dem Sie die versiegelte Verpackung der CD-ROM öffnen.

2. Eigentum
Das Copyright und Eigentumsrecht an dieser Software, dem Logo, dem Namen, der Bedienungsanleitung und allen 
Dokumenten für diese Software liegen bei Roland und seinem Lizenzgeber. Folgende Dinge sind verboten:

• Unerlaubtes Kopieren der Software oder einer zur Verfügung gestellten Datei, eines Programm-Moduls oder der 
Dokumentation.

• Das Dekompilieren oder Zerlegen der Software sowie jedweder Versuch, den Quellcode der Software in Erfahrung 
zu bringen.

3. Einschränkungen dieser Vereinbarung
Roland untersagt Ihnen hiermit, die Software (und alle dazugehörigen Dateien) sowie die Rechte, die Sie kraft dieser 
Vereinbarung erwerben, zu vermieten, zu vertreiben, zu übertragen bzw. Drittpersonen Nutzungsrechte dafür ein-
zuräumen.
Die Software darf auch im Zeitarbeits- und/oder Netzwerkbetrieb nur von Personen genutzt werden, die eine eigene 
Verwendungslizenz besitzen.
Die Software darf nur jeweils von einer Person und nur auf dem Computer verwendet werden, auf dem sie installiert 
wurde.

4. Vervielfältigung
Sie sind berechtigt, eine Reservekopie der Software für Notfälle anzufertigen. Das Eigentum an der kopierten Soft-
ware liegt jedoch ebenfalls bei Roland.
Die Software darf nur jeweils auf der Festplatte eines einzigen Computers installiert werden.

5. Kündigung
Roland behält sich das Recht vor, diese Vereinbarung in einem der folgenden Fälle sofort fristlos zu kündigen:

• Wenn Sie eine Bestimmung dieser Vereinbarung verletzten.
• Wenn Sie einen schweren Vertrauensbruch im Zusammenhang mit dieser Vereinbarung begehen.

6. Haftungsbeschränkungen
Roland behält sich das Recht vor, die technischen Daten und Ausführung dieser Software ohne Vorankündigung zu 
ändern. Roland haftet nicht für Schäden, die sich aus der Verwendung der Software oder der Ausübung der Lizenz-
rechte dieser Vereinbarung ergeben.

7. Geltendes Recht
Diese Vereinbarung unterliegt der japanischen Rechtsprechung. Ausschließlicher Gerichtsstand ist der japanische 
Gerichtshof.

Roland-Lizenzvereinbarung

R1–051220
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Funktionen

    
Unter Windows
• Mit dem beiliegenden “Roland CutStudio”-Programm können Sie bedruckte Aufkleber oder Lettern erstellen.

Siehe “Über die beiliegende Software” auf S. 10.

• Zum Lieferumfang gehört ein Plug-In für Adobe Illustrator namens “CutStudio Plug-in for Adobe Illustrator”. Die-
ses erlaubt die Übertragung von Schneidedaten, die Sie mit Illustrator erstellt haben, zu CutStudio, um Aufkleber 
und Lettern herzustellen.
Siehe “Software plug-in overview, installation method” im elektronischen Dokument “Windows Advanced Guide”.

Funktionen

CutStudio

CutStudio

Die Form der Aufkleber können Sie selbst festlegen. Siehe “Ausschneiden” auf S. 14.

STIKA

Aufkleber

Für die Fertigung bedruckter Aufkleber benötigen Sie einerseits den STIKA und andererseits 
einen geeigneten Drucker. Siehe das elektronische Dokument “Windows Advanced Guide”.

STIKA Aufkleber mit BildDrucker

Illustrator
+

CutStudio

Illustrator
+

CutStudio

Herstellung von Aufklebern anhand von Illustrator-Daten.
Siehe das elektronische Dokument “Windows Advanced Guide”.

STIKA

Aufkleber

Für die Fertigung bedruckter Aufkleber benötigen Sie einerseits den STIKA und andererseits 
einen geeigneten Drucker. Siehe das elektronische Dokument “Windows Advanced Guide”.

STIKA Aufkleber mit BildDrucker
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• Zum Lieferumfang gehört ein Plug-In für CorelDRAW namens “CutStudio Plug-in for CorelDRAW”. Dieses er-
laubt die Übertragung von Schneidedaten, die Sie mit CorelDRAW erstellt haben, zu CutStudio, um Aufkleber und 
Lettern herzustellen.
Siehe “Software plug-in overview, installation method” im elektronischen Dokument “Windows Advanced Guide”.

• Mit dem beiliegenden “STIKA Navi”-Programm können Sie die Funktionen des STIKA vom Computer aus einstel-
len. Die Bedienoberfläche jenes Programms ist ausgesprochen intuitiv.
Siehe “STIKA Navi Overview” im elektronischen Dokument “Windows Advanced Guide”.

Für den Macintosh
• Mit dem Plug-In “CutStudio Plug-in for Adobe Illustrator” können Sie in Illustrator erstellte Objekte ausschneiden.

Siehe “Auf Macintosh-Computern” auf S. 13.

CorelDRAW
+

CutStudio

Herstellung von Aufklebern anhand von CorelDRAW-Daten.
Siehe das elektronische Dokument “Windows Advanced Guide”.

STIKA

Aufkleber

Sie können z.B. überprüfen, ob es zu einem Materialstau gekommen ist.
Siehe das elektronische Dokument “Windows Advanced Guide”.

STIKA Navi-Bedienfenster

STIKA

Sie können Materialstücke, die noch nicht ausgeschnitten wurden, zum Erstellen neuer Ob-
jekte verwenden. Siehe das elektronische Dokument “Windows Advanced Guide”.

STIKA

Noch verwendbares Material

Klicken

STIKA Navi-Bedienfenster

Klicken

Illustrator
+

CutStudio

Herstellung von Aufklebern anhand von Illustrator-Daten.
Siehe das elektronische Dokument “Macintosh Cutting Guide”.

STIKA

Aufkleber
5
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Vorsichtsmaßnahmen

                             
Über die ACHTUNG- und VORSICHT-Meldungen

Andere Symbole

• Versuchen Sie niemals, das Gerät zu öffnen oder zu 
modifizieren.
Sonst könnten Sie nämlich einen Stromschlag erleiden 
bzw. einen Brand verursachen. Überlassen Sie alle War-
tungsarbeiten einer anerkannten Kundendienststelle.

• Verhindern Sie, dass Kinder in unmittelbarer Nähe des 
Geräts spielen.
Das Gerät enthält Bauteile und Partien, an denen man 
sich leicht verletzen kann. Im Extremfall führt dies zu 
Erblindung, Erstickung oder anderen schweren Verletzungen.

• Verwenden Sie nur Zubehör (Verbrauchsgüter, Netz-
teil, Stromkabel usw.), das ausdrücklich für dieses 
Gerät empfohlen wird.
Andere Zubehörteile können Verletzungen verursachen.

• Verbinden Sie das Gerät nur mit einer Steckdose, wel-
che die auf dem Typenschild des Gerätes erwähnten 
Anforderungen erfüllt.
Eine falsche Netzspannung bzw. eine ungenügende 
Strommenge können einen Brand oder einen Strom-
schlag verursachen.

• Behandeln Sie das Netzkabel und die verwendete Steck-
dose mit der gebührenden Umsicht. Wenn eines von 
beiden beschädigt ist, müssen Sie sofort den Netzan-
schluss lösen.
Sonst könnten Sie nämlich einen Stromschlag erleiden bzw. einen 
Brand verursachen.

• Verbinden Sie das Gerät nur mit einem Verlängerungs-
kabel, das die auf dem Typenschild erwähnten Anforde-
rungen erfüllt.
Außerdem dürfen Sie dort keine anderen Geräte mit 
hohem Stromverbrauch anschließen, weil sonst Brandge-
fahr besteht.

• Stellen Sie das Gerät immer so auf, dass das Netzkabel 
jederzeit schnell erreichbar ist.
Im Notfall müssen Sie nämlich so schnell wie möglich 
den Netzanschluss lösen. Stellen Sie das Gerät immer in 
die unmittelbare Nähe der verwendeten Steckdose. Las-
sen Sie aber so viel Freiraum, dass das Netzkabel im Not-
fall sofort gelöst werden kann.

• Wenn Sie etwas Abnormales (Rauch, Funken, Brandge-
ruch, starken Lärm usw.) an Ihrem Gerät bemerken, 
müssen Sie sofort den Netzanschluss lösen. Verwenden 
Sie niemals sichtlich oder nachweislich beschädigte 
Kabel usw.
Sonst könnten Sie nämlich einen Stromschlag erleiden 
bzw. einen Brand verursachen. Wenden Sie sich lieber 
sofort an Ihren Roland DG-Händler oder eine anerkann-
te Kundendienststelle.

• Wenn Sie das Gerät längere Zeit nicht verwenden 
möchten, sollten Sie den Netzanschluss lösen.
So vermeiden Sie Schäden und Unfälle, wenn ein Leck 
auftritt bzw. wenn sich das Gerät plötzlich in Bewegung 
setzt.

• Verwenden Sie das Gerät nie im Freien bzw. an extrem 
feuchten Orten. Außerdem darf es niemals Regen, 
einem Wasserstrahl usw. ausgesetzt werden. Berühren 
Sie das Gerät nie mit feuchten Händen.
Sonst könnten Sie nämlich einen Stromschlag erleiden 
bzw. einen Brand verursachen.

Vorsichtsmaßnahmen

 ACHTUNG
Diese Meldung weist Sie auf ein (wenn auch geringes) Risiko hin, das Ihr Leben bedrohen oder 
zu schweren Verletzungen führen könnte, wenn Sie die betreffenden Hinweise missachten.

 VORSICHT
Diese Meldung weist Sie auf Verletzungsgefahr bzw. die Möglichkeit hin, dass das Gerät bei un-
sachgemäßer Behandlung beschädigt werden könnte.
* Mit “Sachschäden” sind Schäden oder andere nachteilige Auswirkungen auf den Wohnbe-
reich, die Möbel und eventuell Haustiere gemeint.

Das Dreieck weist Sie auf wichtige Hinweise bzw. Warnungen hin. Die genaue Bedeutung des Symbols richtet sich nach 
dem Zeichen innerhalb des Dreiecks. So bedeutet das hier gezeigte Symbol z.B., dass die Gefahr eines Stromschlags besteht.

Ein Verbotssymbol (durchgestrichener Kreis) weist Sie auf Dinge hin, die Sie niemals selbst ausführen sollten (die verboten 
sind). Was genau Sie unterlassen sollen, wird mit dem Symbol innerhalb des Kreises angegeben. So bedeutet das links ge-
zeigte Symbol, dass Sie das Gerät niemals öffnen bzw. modifizieren dürfen.

Ein schwarzer Kreis bezeichnet Dinge, die Sie unbedingt ausführen müssen. Auch hier gilt, dass die Handlung mit einem 
Symbol angegeben wird. Nebenstehendes Symbol bedeutet beispielsweise, dass Sie den Netzanschluss lösen müssen.

ACHTUNG

Typenschild
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 Andere Symbole

                        
• Sorgen Sie dafür, dass keine Gegenstände wie Nadeln, 
Münzen, Streichhölzer usw. ins Geräteinnere gelangen. 
Außerdem dürfen keine Flüssigkeiten ins Geräteinnere 
tropfen.
Münzen, Streichhölzer, Getränke usw., die über die Lüf-
tungsschlitze ins Geräteinnere gelangen, können einen 
Brand oder einen Kurzschluss verursachen. Lösen Sie dann sofort 
den Netzanschluss und wenden Sie sich an eine anerkannte Roland 
DG-Kundendienststelle.

• Stellen Sie niemals brennbare Gegenstände in die Nähe 
des Geräts. Verwenden Sie niemals feuergefährliche 
Sprays in der Nähe des Geräts. Betreiben Sie das Gerät 
nie an Orten, wo sich Gase ansammeln können.
Sonst besteht Brand- oder sogar Explosionsgefahr.

• Vorsicht: Schneidewerkzeug.
Dieses Gerät enthält ein Werkzeug. Seien Sie vorsichtig, 
damit Sie sich nicht verletzen.

• Lösen Sie vor dem Reinigen des Geräts und Sonderzu-
behörs den Netzanschluss.
Tun Sie das nämlich nicht, so bestehen Stromschlagge-
fahr und die Möglichkeit, dass Sie sich verletzen.

• Stellen Sie das Gerät auf eine ebene und stabile Oberflä-
che.
Wenn Sie das Gerät an einem ungeeigneten Ort aufstel-
len, kann es zu schweren Unfällen kommen, weil es fallen könnte.

• Dieses Gerät eignet sich nur für bestimmte Aufgaben 
und sollte niemals für andere Zwecke verwendet wer-
den. Außerdem darf es nie zu stark beansprucht wer-
den.
Sonst besteht nämlich Brandgefahr.

Dieses ist ein Präzisionsgerät. Um einen ordnungsgemäßen Betrieb zu gewährleisten, müssen Sie folgende Punkte 
beachten. Sonst kann es zu einem Leistungsabfall, Fehlfunktionen und/oder schweren Schäden am Gerät kommen.

Dieses Gerät ist ein Präzisionsgerät
Gehen Sie umsichtig damit um und sorgen Sie dafür, dass es niemals starken Erschütterungen ausgesetzt wird.

Stellen Sie das Gerät an einem geeigneten Ort auf.
• Betreiben Sie das Gerät nur an Orten, wo sich die Temperatur und Luftfeuchtigkeit im vorgeschriebenen Bereich 

befinden.
• Stellen Sie das Gerät an einem stabilen Ort auf, wo eine problemlose Bedienung gewährleistet ist. Siehe “Hinweise 

zum Aufstellungsort” auf S. 9.

Wichtige Hinweise zum Anschließen der Kabel
Stecken Sie das Netzkabel und das Verbindungskabel für den Computer immer sorgfältig und vollständig in die be-
treffenden Anschlüsse. Siehe “Anschließen der Kabel” auf S. 10.

Transport des Geräts
Zum Transport muss das Gerät mit beiden Händen an der Unterseite gehalten werden. Halten Sie das Gerät nie an 
anderen Stellen fest, weil Sie es sonst beschädigen können.

VORSICHT

Wichtige Betriebshinweise
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Vorbereitungen für die Aufstellung

    
1-1 Lieferumfang
Zum Lieferumfang gehören folgende Dinge. Kontrollieren Sie nach dem Auspacken zuerst, ob Sie alles bekommen 
haben:

1.  Vorbereitungen für die Aufstellung

Netzteil Netzkabel USB-Kabel Reserve-Messer-
schutz

* Die Form richtet sich nach 
dem Modell.

Messer Messereinheit, Druckstift
*Die Messereinheit, das Messer und 
der Druckstift sind bereits eingebaut.

Testmaterial (farbig) Applikationsbogen 
(durchsichtig)

CD-ROM Bedienungsanleitung
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 Typen- und andere Hinweisschilder

          
1-2 Die Bedienelemente

1-3 Typen- und andere Hinweisschilder

1-4 Entfernen des Verpackungs-
materials

Im Sinne eines sicheren Transports wird das Gerät 
vor der Auslieferung mit Halterungen, Klebeband 
usw. versehen. Nach der Aufstellung muss dieses 
Material entfernt werden.

Achtung: Entfernen Sie alles Verpackungsmaterial. Sonst 
kann es bei der Inbetriebnahme zu Fehlfunktionen oder 
sogar schweren Schäden kommen.

1-5 Aufstellung
Hinweise zum Aufstellungsort

Stellen Sie das Gerät an einem stabilen Ort auf, wo 
eine problemlose Bedienung gewährleistet ist. An-
dernfalls kann es zu Unfällen, Funktionsstörungen 
bzw. schweren Schäden am Gerät kommen.

Achtung: Verwenden Sie das Gerät nie im Freien bzw. an 
extrem feuchten Orten. Außerdem darf es niemals Regen, 
einem Wasserstrahl usw. ausgesetzt werden. Berühren Sie 
das Gerät nie mit feuchten Händen. Sonst könnten Sie 
nämlich einen Stromschlag erleiden bzw. einen Brand ver-
ursachen.

Andruckrollen

Messerschutz Messereinheit

* Hebel für die
Bogeneinstellung

Haube des 
Wagenbügels

Schneidewagen

Netzteilanschluss

USB-Anschluss

[POWER]-Taste

[POWER]-Diode

* Der SV-15 ist rechts und links mit einem Einzugshe-
bel ausgestattet. Der SV-12/SV-8 weist einen Hebel 
auf (rechts).

Rad für den Material-
transport

Seriennummer
Diese benötigen Sie, wenn Sie Wartungsarbeiten, Repa-
raturen oder Hilfestellung in Anspruch nehmen möchten. 
Entfernen Sie diesen Aufkleber niemals und sorgen Sie 
dafür, dass er lesbar bleibt.

Netzanforderungen
Schließen Sie das Gerät nur an eine Steckdose 
an, die den hier erwähnten Anforderungen 
(Spannung, Netzfrequenz und Stromstärke) ent-
spricht.

Verpackungsmaterial
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Vorbereitungen für die Aufstellung

                                 
Achtung: Stellen Sie niemals brennbare Gegenstände in 
die Nähe des Geräts. Verwenden Sie niemals feuergefährli-
che Sprays in der Nähe des Geräts. Betreiben Sie das Gerät 
nie an Orten, wo sich Gase ansammeln können. Sonst be-
steht Brand- oder sogar Explosionsgefahr.
Achtung: Stellen Sie das Gerät immer so auf, dass das 
Netzkabel jederzeit schnell erreichbar ist. Im Notfall müs-
sen Sie nämlich so schnell wie möglich den Netzanschluss 
lösen. Stellen Sie das Gerät immer in die unmittelbare 
Nähe der verwendeten Steckdose. Lassen Sie aber so viel 
Freiraum, dass das Netzkabel im Notfall sofort gelöst wer-
den kann.
Achtung: Stellen Sie das Gerät auf eine Ebene und stabile 
Oberfläche. Wenn Sie das Gerät an einem ungeeigneten 
Ort aufstellen, kann es zu schweren Unfällen kommen, 
weil es fallen könnte.

Ungeeignete Aufstellungsorte
• Orte, die Erschütterungen oder Vibrationen ausge-

setzt sind.
• Geneigte, unebene und/oder unstabile Oberflächen.
• Staubige Orte.
• Orte, die starken elektrischen, magnetischen oder 

elektromagnetischen Feldern ausgesetzt sind.
• Orte, an denen die Wärme ungenügend abgeführt 

wird.

Mindestabmessungen des Aufstellungsorts

1-6 Anschließen der Kabel
Achtung: Verbinden Sie das Gerät nur mit einer Steckdo-
se, welche die auf dem Typenschild des Gerätes erwähnten 
Anforderungen erfüllt. Eine falsche Netzspannung bzw. 
eine ungenügende Strommenge können einen Brand oder 
einen Stromschlag verursachen.
Achtung: Behandeln Sie das Netzkabel und die verwendete 
Steckdose mit der gebührenden Umsicht. Wenn eines von 
beiden beschädigt ist, müssen Sie sofort den Netzanschluss 
lösen. Sonst könnten Sie nämlich einen Stromschlag erlei-
den bzw. einen Brand verursachen.
Achtung: Verbinden Sie das Gerät nur mit einem Verlän-
gerungskabel, das die auf dem Typenschild erwähnten An-
forderungen erfüllt. Außerdem dürfen Sie dort keine an-
deren Geräte mit hohem Stromverbrauch anschließen, 
weil sonst Brandgefahr besteht.
Achtung: Verwenden Sie nur hochwertige Netzteile, die 
mit diesem Gerät kompatibel sind. Die Verwendung eines 
nicht kompatiblen Netzteils kann zu schweren Schäden 
führen.

Verwenden Sie das beiliegende USB-Kabel, um die 
Verbindung mit dem Computer herzustellen.
Achtung: Schließen Sie das USB-Kabel erst an, wenn das 
Treiber-Installationsprogramm Sie ausdrücklich dazu auf-
fordert. Wenn Sie das USB-Kabel schon vorher anschlie-
ßen, lässt sich der Treiber u.U. nicht installieren, so dass 
Sie das Gerät nicht betreiben können. Siehe “Installieren 
des Treibers” auf S. 11.
Achtung: Verwenden Sie niemals einen USB-Hub o.ä.

1-7 Installieren der Programme
Hier erfahren Sie, wie man die beiliegende Software 
installiert.

Über die beiliegende Software
Im Lieferumfang befindet sich eine CD-ROM mit 
folgenden Programmen.
Programme für Windows
STIKA-Treiber—Dieser Windows-Treiber ist not-
wendig, um Daten vom Computer zum Gerät zu 
übertragen. Sie müssen ihn auf jeden Fall installie-
ren.

STIKA Navi—Dieses Programm erlaubt die Fernbe-
dienung des Geräts von Computer aus. Damit kön-
nen Sie das Messer zur gewünschten Stelle führen 
und den Materialtransport testen. Das Programm 
wird gemeinsam mit dem STIKA-Treiber installiert.

Das Material wird beim Schneiden vor und zu-
rück bewegt. Stellen Sie keinerlei Gegenstän-
de vor die Vorder- oder Rückseite. Stellen Sie 
das Gerät niemals unmittelbar an eine Wand 
bzw. in einen Schrank.

Sorgen Sie dafür, dass 
das Rad für den Materi-
altransport niemals von 
anderen Gegenstän-
den behindert wird.

Stellen Sie das Gerät 
immer so auf, dass Sie 
das Netzkabel bei Be-
darf sofort ziehen kön-
nen.

Netzteil Netzkabel

Netzteilanschluss

USB-Kabel
Netzanforderungen

Achtung: Schließen Sie 
das USB-Kabel NOCH 
NICHT an.
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Bedienungsanleitung

 

 Anschließen der Kabel

                               
Roland CutStudio—“Roland CutStudio” ist ein 
Programm, mit dem man einerseits Schneidedaten 
anlegen und die Objekte andererseits ausschneiden 
kann.

CutStudio Plug-In für Adobe Illustrator—Mit die-
sem Plug-In können Sie in Adobe Illustrator erstellte 
Objekte sofort ausschneiden.

CutStudio Plug-In für CorelDRAW—Mit diesem 
Plug-In können Sie in CorelDRAW erstellte Objekte 
sofort ausschneiden.

Programme für Macintosh
CutStudio Plug-In für Adobe Illustrator—Mit die-
sem Plug-In können Sie in Adobe Illustrator erstellte 
Objekte sofort ausschneiden.

Auf Windows-Computern
Systemanforderungen
Systemanforderungen für die USB-Verbindung
Unter Windows funktioniert eine USB-Verbindung 
nur, wenn der Computer folgende Anforderungen 
erfüllt. Alle anderen Konfigurationen sind nicht 
kompatibel.

Systemanforderungen für Roland CutStudio

Systemanforderungen für den STIKA-Treiber

Installieren des Treibers
Außer dem Treiber wird auch STIKA Navi instal-
liert.
Achtung: Verbinden Sie das Gerät erst mit dem Compu-
ter, wenn Sie ausdrücklich dazu aufgefordert werden. Tun 
Sie das nämlich nicht, so wird der Treiber falsch bzw. nur 
teilweise installiert. Siehe “Erste Hilfe bei Problemen…” 
auf S. 30.

A Vergewissern Sie sich vor Starten der Installation, 
dass das USB-Kabel NICHT angeschlossen ist.

B Fahren Sie Windows hoch. Wenn Sie das Programm 
unter Windows 2000/XP installieren, müssen Sie sich 
als “Administrator” anmelden.

C Legen Sie die beiliegende CD-ROM in das Laufwerk 
des Rechners.
Nach einer kurzen Zeit erscheint folgendes Menü.

D Klicken Sie auf [Install].
Der “Installation and Setup Guide” erscheint. Unter 
Windows 98 SE, Windows Me und Windows 2000 
erscheinen der “Installation and Setup Guide” sowie 
das “Setup”-Programm.

E Befolgen Sie die Anweisungen im “Installation and 
Setup Guide”, um die Installation fertig zu stellen.

Wenn das “Driver Setup”-Fenster nicht erscheint
Wenn das “Setup”-Programm unter Windows 98 
SE, Windows Me oder Windows 2000 nicht er-
scheint, schauen Sie zuerst in der Taskleiste (am un-
teren Ende Ihres Monitors) nach. Wird dort 
[Driver Setup] angezeigt, so läuft das Programm be-
reits. Klicken Sie dann in der Taskleiste auf 
[Driver Setup], um das “Setup”-Fenster zu öffnen.

Betriebssystem Windows 98 SE (Second Edition)/Me/2000/XP

Computer 1) Computer, auf dem Windows 98 SE/Me/
2000/XP vorinstalliert ist oder auf dem Win-
dows Me/2000/XP nachträglich installiert 
wurde.
2) Computer, dessen Hersteller die USB-Funk-
tion garantieren kann.

Betriebssystem Windows 98 SE (Second Edition)/Me/2000/XP

Computer Auf Windows-Computern

Laufwerk CD-ROM-Laufwerk

Monitor Windows-kompatibler Monitor mit 16-Bit-
Farbdarstellung (High Color) oder besser

Arbeitsspei-
cher (RAM)

128MB oder mehr

Freie Festplat-
tenkapazität 
(für die Installa-
tion)

10MB

Betriebssystem Windows 98 SE (Second Edition)/Me/2000/XP

Computer 1) Computer, auf dem Windows 98 SE/Me/
2000/XP vorinstalliert ist oder auf dem Win-
dows Me/2000/XP nachträglich installiert 
wurde.
2) Computer, dessen Hersteller die USB-Funk-
tion garantieren kann.

Klicken Sie auf 
[Install].

Hier klicken.Taskleiste
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Vorbereitungen für die Aufstellung

                     
Installieren von CutStudio
Installieren Sie das Programm “CutStudio”.

A Rufen Sie das Menü der Software (“Roland STIKA 
Software Package”) auf.

B Klicken Sie auf [Install].
Befolgen Sie danach die Bildschirmanweisungen, um 
die Installation durchzuführen. Installieren Sie dann 
den “Windows Advanced Guide”.

Aufrufen der Online-Hilfe von Roland CutStudio
Klicken Sie auf die [Start]-Schaltfläche, wählen Sie 
mit dem Mauszeiger [Alle Programme] (bzw. 
[Programme]), dann [Roland CutStudio] und 
schließlich [CutStudio Help].

* Die Online-Hilfe kann auch über das Menü von 
CutStudio aufgerufen werden.

Installieren des ‘Windows Advanced Guide’
A Rufen Sie das Menü der Software (“Roland STIKA 

Software Package”) auf.

B Klicken Sie auf [Install].
Das “Setup”-Fenster erscheint. Befolgen Sie danach 
die Bildschirmanweisungen, um die Installation 
durchzuführen.

C Klicken Sie im “Setup”-Menü oben rechts auf das [X], 
um das Fenster zu schließen.

Durchlesen des ‘Windows Advanced Guide’
Klicken Sie auf die [Start]-Schaltfläche, wählen Sie 
mit dem Mauszeiger [Alle Programme] (bzw. 
[Programm]), dann [Roland SV Series Manual] und 
schließlich [Advanced Guide].

Installieren des CutStudio-Plug-Ins
Hinweise zur Installation des CutStudio-Plug-Ins 
finden Sie im elektronische Dokument “Windows 
Advanced Guide”.

Klicken Sie auf 
[Install].
Das “Setup”-
Fenster erscheint.

Klicken Sie auf 
[Install].
Das “Setup”-
Fenster erscheint.
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 Anschließen der Kabel
Auf Macintosh-Computern
Systemanforderungen
Schließen Sie den STIKA nur an einen Macintosh an, 
der folgende Voraussetzungen erfüllt.
Betriebssystem: Mac OS 9 oder neuer (die Versionen 
Adobe Illustrator 9/10/CS funktionieren einwand-
frei)

Installieren der Programme
Wie Sie das Programm und den “Macintosh Cutting 
Guide” installieren, entnehmen Sie dem “Mac OS 
Installation and Setup Guide” auf der beiliegenden 
CD-ROM. Führen Sie die nachstehenden Schritte 
aus, um die Datei auf Ihrem Macintosh aufzurufen 
und folgen Sie dann den Installationsanweisungen.

A Legen Sie die beiliegende CD-ROM in das Laufwerk 
des Rechners.

B Das “Roland SV Series”-Symbol erscheint auf dem 
Desktop. Doppelklicken Sie darauf.

C Doppelklicken Sie auf das “Install_e.html”-Symbol.
Der “Mac OS Installation and Setup Guide” er-
scheint.

Befolgen Sie danach die Anweisungen des “Mac OS 
Installation and Setup Guide”, um das Programm 
und den “Macintosh Cutting Guide” zu installieren.
13



SV-15/12/8 – Ausführen eines Schneideauftrags
Hier werden die grundlegenden Arbeitsschritte eines Schneideauftrags (unter Windows) beschrieben. Hinweise zu 
Funktionen, die in diesem Kapitel nicht behandelt werden, finden Sie im “Windows Advanced Guide” (digitale An-
leitung).

2-1 Bevor Sie sich an die Arbeit machen
Unterstützte Materialtypen

Dieses Gerät erlaubt die Verwendung folgender Materialtypen.

* Bestimmte Materialtypen können mit diesem Gerät nicht ausgeschnitten werden.

Verwenden Sie niemals Material, das folgende Eigenschaften aufweist. Sonst könnte es beim Ausschneiden nämlich 
zu einem Materialstau kommen.

• Welliges Material.
• An der Vorderseite schief abgeschnittenes Material.
• Material mit ungleichmäßigem linken und rechten Rand.
• Material, das länger ist als 1100mm.

Verwendung von Rollenmaterial
Rollenmaterial sollten Sie nach Beenden eines Ob-
jekts noch mindestens 40mm weiter transportieren, 
um das Objekt unbeschädigt abtrennen zu können. 
Das Gerät erlaubt die Verwendung von Material, das 
bis zu 1100mm lang ist. Allerdings können nur 
1000mm tatsächlich für Objekte verwendet werden.

Achtung: Schneiden Sie das Material immer gerade ab. 
Wenn Sie es nämlich schief abschneiden, kann es beim 
Ausschneiden des nächsten Objekts zu Fehlfunktionen 
kommen. Es ist sogar nicht ausgeschlossen, dass sich das 
Material unter den Andruckrollen wegrutscht.

2-2 Ausschneiden
Sehen wir uns nun an, wie man folgendes Objekt an-
fertigt und danach ausschneidet.

Führen Sie die nachfolgende erwähnten Schritte in 
der richtigen Reihenfolge durch.

2. Ausführen eines Schneideauftrags

SV-15 SV-12 SV-8

Abmessungen • Breite: 360~381mm; 280~305mm 
(Länge: A3, Breite: A4). Siehe “Än-
dern der Materialbreite (nur beim 
SV-15)” auf S. 15.

• Länge: Bis zu 1100mm

• Breite: 280~305mm (Länge: A3, 
Breite: A4)

• Länge: Bis zu 1100mm

• Breite: 200~215mm (Länge: A4)
• Länge: Bis zu 1100mm

Materialtypen* • Vinylfolie (maximale Stärke: 0,1mm; maximale Stärke inklusive Unterlage: 0,3mm)
• Etikettpapier (maximale Stärke inklusive Unterlage: 0,3mm)

Up to 
1100 mm  
(43-1/4 in.)

Maximal 
1100mm
14



Bedienungsanleitung Bevor Sie sich an die Arbeit machen
Schritt 1: Einlegen des Materials
A Schalten Sie das Gerät aus.

B Schauen Sie nach, ob das Material eingezogen werden 
kann und ob es die Andruckrollen berührt.

Achtung: Die Andruckrollen des SV-15 kann man der Ma-
terialbreite entsprechend verschieben. Ziehen Sie das Ma-
terial erst danach ein. Siehe “Ändern der Materialbreite 
(nur beim SV-15)” auf S. 15.

C Ordnen Sie das Material so an, dass der linke Rand 
parallel zur Hilfslinie liegt.

Wenn das nicht der Fall ist, müssen Sie das Material 
so nach innen ziehen, dass es einerseits parallel liegt 
und sich andererseits unter den Andruckrollen be-
findet.

D Drehen Sie am Transportrad, um das Material weiter 
in das Gerät zu ziehen. Drehen Sie das Rad danach 
wieder zurück. Das Material darf nicht unter den An-
druckrollen wegrutschen.

Wenn das Material schief transportiert wird oder 
unter den Andruckrollen wegrutscht, müssen Sie es 
erneut einziehen.

E Orientieren Sie sich beim Anordnen des Materials am 
Messerschutz.

Laden des Testmaterials
Die Richtung, in der man das Testmaterial einziehen 
muss, richtet sich nach dem verwendeten Modell.

SV-15/SV-12— In der Breite (Querformat)

SV-8—In der Länge (Hochformat)
Im Falle des SV-15 müssen Sie die Breite des zu la-
denden Materials auf 280~305mm stellen. Siehe wei-
ter unten.

Ändern der Materialbreite (nur beim SV-15)
Im Falle des SV-15 können Sie die Breite des zu la-
denden Materials auf 360~381mm oder 
280~305mm stellen. Die Breite muss durch Ver-
schieben der Andruckrollen und mit Hilfe der Trei-
berparameter eingestellt werden.

A Heben Sie den rechten Einzugshebel an.

B Entfernen Sie den Stopper der Andruckrolle.

Achtung: Gehen Sie beim Entfernen des Stoppers behut-
sam vor, um ihn nicht zu verformen. Wenn er nämlich zu 
weit aufgebogen wird, löst er sich eventuell, wenn Sie ihn 
später wieder anbringen.

Andruckrolle

Das Material muss sich parallel zu den Andruckrollen befinden.

Hilfslinie

Rad für den Materialtransport

Einzugshebel (rechts)

Stopper der Andruckrolle
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SV-15/12/8 – Ausführen eines Schneideauftrags
C Schieben Sie die rechte Andruckrolle zum Material-
rand und bringen Sie den Stopper wieder an.

D Senken Sie den rechten Einzugshebel wieder ab.

E Laden Sie Material.

Siehe “Schritt 1: Einlegen des Materials” auf S. 15.

F Stellen Sie im Treiber ein, wie groß der Schneidebe-
reich ist.
Siehe weiter unten.

Schritt 2: Erstellen von Schneidedaten
Mit dem Programm “CutStudio” können Sie 
Schneidedaten erstellen. Wie man mit CutStudio ar-
beitet, wird in der Online-Hilfe des Programms er-
klärt.
Achtung: Unter Windows 2000/XP müssen Sie sich als 
“Administrator” anmelden.

Starten Sie CutStudio.

A Klicken Sie auf [Start].

B Wählen Sie [Alle Programme ] (oder [Programme]), 
[Roland CutStudio] und klicken Sie auf [CutStudio].

Nehmen Sie die Einstellungen für den Schneidebe-
reich vor.

A Klicken Sie auf [File] und anschließend auf [Cutting 
Setup].

Nun erscheint das “Cutting Setup”-Fenster.

B Wählen Sie mit [Name] das verwendete Gerät.

C Klicken Sie auf [Properties].

Andruckrolle
280~305mm

Andruckrolle
360~381mm

Einzugshebel (rechts)

280~305mm

360~381mm
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Bedienungsanleitung Bevor Sie sich an die Arbeit machen
Nun erscheint das “Properties”-Fenster.

D Klicken Sie auf das [Size]-Register.

E Der Schneidebereich richtet sich in erster Linie nach 
den Materialabmessungen.

• Klicken Sie auf [ ] und stellen Sie die Breite entwe-
der auf 250 oder 340mm (nur beim SV-15).
Achtung: Wenn Sie das Testmaterial verwenden möchten, 
müssen Sie “250mm” wählen.
Achtung: Beim SV-12/SV-8 kann man die Materialbreite 
nicht ändern.

• Wählen Sie als “Length” immer einen Wert, der et-
was kürzer ist als die Materiallänge (weil ein Rand 
eingehalten werden muss).
Siehe “Schneidebereich” auf S. 25.

F Klicken Sie auf [OK].

G Schließen Sie das “Cutting Setup”-Fenster, indem Sie 
erneut auf [OK] klicken.
Damit ist der Schneidebereich eingestellt.

Legen Sie den Text und die Formen an, die Sie ausschneiden möchten.
Für unser Beispiel wollen wir als Text das Wort “SA-
LE” eingeben und mit einem rechteckigen Rahmen 
versehen, was das spätere Ablösen erleichtert.

A Klicken Sie auf [ ].

B Klicken Sie auf eine beliebige Stelle innerhalb des wei-
ßen Bereichs und tippen Sie dann das Wort “SALE”.

C Klicken Sie auf [ ].
Um den Text herum befinden sich - und �-Sym-
bole.

D Verschieben Sie die Textfeldsymbole  und �, um 
die Textgröße zu ändern.

E Klicken Sie auf [ ].

F Ziehen Sie einen Rahmen um den Text “SALE”.
Klicken Sie auf die linke obere Ecke und ziehen Sie 
bei gedrückter Maustaste nach rechts unten, bis Sie 
die benötigte Größe erreicht haben.

G Klicken Sie auf [ ].

[Size]-Regis-
ter

Schneidebe-
reich

Die weiße Fläche vertritt den 
Schneidebereich. Objekte, die 
außerhalb dieses Bereiches 
liegen, werden nicht ausge-
schnitten.

Klicken und ziehen, bis die ge-
wünschte Größe erreicht ist.
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SV-15/12/8 – Ausführen eines Schneideauftrags
Wählen Sie einen Bereich, der sowohl den Text als 
auch den Rahmen umfasst. Wenn Sie ihn gewählt 
haben, wird die Linienfarbe blau. Verschieben Sie 
die Position zum oberen Ende des Fensters – neben 
den Ursprung.

H Klicken Sie auf [Save].

Nun erscheint das “Save As”-Fenster.

I Wählen Sie unter “Save in” den gewünschten Ordner.

J Geben Sie der Datei einen Namen und klicken Sie auf 
[Save].
Damit sind die erstellten Daten gespeichert.

Wichtiger Hinweis zum Speichern der Daten
Der mit [File]>[Cutting Setup]>[Properties] einge-
stellte Schneidebereich wird nicht gespeichert. Wenn 
Sie die Daten das nächste Mal importieren, müssen 
Sie im [Cutting Setup]-Menü die Einstellungen für 
den Schneidebereich erneut vornehmen.

Schritt 3: Ausschneiden
Vor Starten eines Schneideauftrags müssen Sie 
“Schritt 1: Einlegen des Materials” (S. 15) und 
“Schritt 2: Erstellen von Schneidedaten” (S. 16) aus-
führen.

A Drücken Sie die [POWER]-Taste, um das Gerät einzu-
schalten.

Die [POWER]-Diode blinkt. Der Wagen fährt zum 
linken Rand des Geräts. Wenn die Diode konstant 
leuchtet, ist das Gerät fertig zum Ausschneiden.

B Klicken Sie auf [Cutting].

C Klicken Sie auf [OK].

Die Schneidedaten werden vom Computer übertra-
gen und der Schneidevorgang beginnt. Der Text 
“SALE” und der Rahmen werden ausgeschnitten.

D Drücken Sie die [POWER]-Taste, um das Gerät aus-
zuschalten.
Die [POWER]-Diode muss erlöschen.

Ursprung

Führen Sie den Mauszeiger zu einer Stelle innerhalb des Textes. 
Sobald der Mauszeiger als Kreuz dargestellt wird, können Sie mit 
gedrückter Maustaste ziehen und verschieben.
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Bedienungsanleitung Bevor Sie sich an die Arbeit machen
E Drehen Sie am Transportrad, um das Material aus 
dem Gerät holen zu können.

Abbrechen eines laufenden Schneidevorgangs
A Drücken Sie die [POWER]-Taste, um das Gerät aus-

zuschalten.

B Drücken Sie die [POWER]-Taste erneut, um das Ge-
rät wieder einzuschalten.

Der Schneidewagen fährt zum linken Rand.
Achtung: Wenn Sie den Schneideauftrag mit demselben 
Material wiederholen möchten, müssen Sie es zuerst ent-
nehmen und danach erneut laden.
Achtung: Ein Auftrag kann auch mit “STIKA Navi” abge-
brochen werden. Weitere Hinweise hierzu finden Sie im 
elektronischen Dokument “Windows Advanced Guide”.

Schritt 4: Anbringen des ausgeschnittenen 
Objekts

Zum Anbringen eines ausgeschnittenen Objekts 
muss Applikationsfolie verwendet werden. Schnei-
den Sie ein Stück Applikationsfolie in der passenden 
Größe ab. Reinigen Sie gründlich die Oberfläche, auf 
der Sie das Objekt anbringen möchten; sie muss völ-
lig staub- und fettfrei sein.

A Entfernen Sie alle überflüssigen Materialpartien, so 
dass nur noch der Text übrig bleibt.

Zum Entfernen kleiner Folienreste verwenden Sie 
am besten eine Pinzette.

B Schneiden Sie ein Stück Applikationsfolie in der pas-
senden Größe ab.

Bedecken Sie das ausgeschnittene Material bündig 
mit der Folie, so dass keine Luft mehr dazwischen ge-
langen kann und übertragen Sie dann das Objekt.
Achtung: Am einfachsten lässt sich das Objekt übertragen, 
wenn Sie mit einem Fensterwischer oder der flachen Seite 
eines Lineals über die Applikationsfolie reiben.

C Heften Sie das Objekt samt Applikationsfolie an die 
gewünschte Stelle und drücken Sie beide gut fest.

D Wenn Sie sicher sind, dass das Objekt wirklich fest 
haftet, lösen Sie behutsam die Applikationsfolie.

Achtung: Sollten sich Luftblasen gebildet haben, können 
Sie diese mit einer Nadel aufstechen und das Material wie-
der glatt reiben.
Damit ist das Objekt an der gewünschten Stelle ange-
bracht.

Nach dem Ausschneiden
Übertragen Sie Objekte nach Möglichkeit immer un-
mittelbar nach dem Ausschneiden. Wenn sich näm-
lich Staub auf der Oberfläche ansammelt, kann es 
sein, dass die Applikationsfolie nicht mehr genügend 
haftet.

Applikationsfolie
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SV-15/12/8 – Funktionen des STIKA
Hier wird erklärt, wie man den Messervorsprung 
einstellt, das Material gerade einzieht und Schneide-
daten anlegt.

3-1 Optimieren der Schneide-
parameter

Kontroller der Schneideparameter
Ein optimales Ergebnis erzielen Sie nur, wenn Sie vor 
wichtigen Aufträgen einen Schneidetest durchfüh-
ren, um die Einstellungen zu überprüfen. Das ist au-
ßerdem bei Verwendung eines ungewohnten Mate-
rialtyps und zum Überprüfen des Messervorsprungs 
notwendig.
Achtung: Vor Ausführen des Schneidetests muss Material 
geladen werden. Wenn Sie das nicht tun, werden das Mes-
ser und der Messerschutz beschädigt.
Achtung: Verschieben Sie den Schneidewagen niemals 
von Hand. Das könnte nämlich zu Schäden am Gerät füh-
ren.
Achtung: Berühren Sie keine beweglichen Partien, wäh-
rend das Gerät am Arbeiten ist. Das könnte nämlich zu 
Funktionsstörungen führen.

A Ziehen Sie Material ein.
Siehe “Schritt 1: Einlegen des Materials” auf S. 15.

B Aktivieren Sie den [POWER]-Schalter (Diode muss 
leuchten) und halten Sie ihn mindestens 2 Sekunden 
gedrückt.

C Sobald sich der Wagen in Bewegung setzt, können Sie 
die Taste wieder freigeben.

Der Schneidevorgang beginnt ab der aktuellen Mes-
serposition. Es wird das unten gezeigte Objekt ausge-
schnitten.

Wenn Sie später erneut einen Schneidetest ausfüh-
ren möchten, müssen Sie die [POWER]-Taste wie-
der 2 Sekunden oder länger gedrückt halten. (War-
ten Sie aber, bis der zuletzt gestartete Schneideauf-
trag beendet ist.) Für einen solchen Test wird auto-
matisch ein Gebiet gewählt, das sich weit genug vom 
zuletzt ausgeschnittenen Objekt entfernt befindet.

D Entfernen Sie die ausgeschnittenen Formen und 
überprüfen Sie ihre Qualität.
Die Schneidequalität richtet sich entscheidend nach 
dem Messervorsprung. Wenn sich die Testobjekte 
nicht erwartungsgemäß entfernen lassen, müssen Sie 
den Messervorsprung folglich ändern. Siehe “Ein-
stellen des Messervorsprungs” unten.

Auf der Materialunterlage kann man eine feine Messer-
spur erkennen
Das weist auf einen optimalen Messervorsprung hin. 
In diesem Fall ist keine Korrektur erforderlich.

Das Material lässt sich nur schwer von der Unterlage 
entfernen
Die Messerspur ist kaum sichtbar.
Die Bahnen werden ungleichmäßig ausgeschnitten.

Erhöhen Sie den Messervorsprung.

Die Messerspur ist zu tief bzw. die Unterlage wurde 
ebenfalls ausgeschnitten
Die Unterlage wurde ebenfalls ausgeschnitten.
Das Material wird beim Schneiden wellig.

Verringern Sie den Messervorsprung.

Einstellen des Messervorsprungs
Achtung: Berühren Sie die Messerspitze niemals mit blo-
ßen Fingern, weil sie ausgesprochen scharf ist. Sonst be-
steht nämlich Verletzungsgefahr.

A Schalten Sie das Gerät aus.

3.  Funktionen des STIKA

2 Sekunden 
oder mehr

Optimaler Messer-
vorsprung

Zu kleiner Messer-
vorsprung.

Zu großer Messer-
vorsprung.
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Bedienungsanleitung Bevor Sie sich an die Arbeit machen
B Lösen Sie die Schraube und entnehmen Sie die Cutter-
Einheit.

C Stellen Sie den Messervorsprung ein.

Drehen Sie die Kappe in die gezeigte Richtung, um 
den Messervorsprung zu erhöhen. Jeder Schritt ent-
spricht 0,1mm.

D Stützen Sie die Schraube ab, während Sie die Mes-
sereinheit einsetzen.

E Drehen Sie die Schraube fest.

Ziehen Sie den Cutter vorsichtig hoch, um zu über-
prüfen, ob er festsitzt.

F Führen Sie den Schneidetest durch und kontrollieren 
Sie, ob das Material sauber ausgeschnitten wurde.
Wiederholen Sie dieses Verfahren so oft, bis die 
Schneidequalität optimal ist. Siehe “Kontroller der 
Schneideparameter” auf S. 20.

Anhaltspunkte für einen geeigneten Messervorsprung
Anhand folgender Formel können Sie den erforder-
lichen Messervorsprung ungefähr ermitteln.

* Tipp

Wenn die Messerbahnen eine sichtbare Spur auf der 
Unterlage hinterlassen, ist der Messervorsprung op-
timal.

3-2 Andere Anordnung des 
Materials

Wenn das Material nicht richtig eingezogen wurde, 
kann es während des Transports verrutschen. Der/
die Einzugshebel kann/können angehoben werden, 
um das Material zu verschieben.

A Heben Sie den Einzugshebel an.

B Schieben Sie das Material abwechselnd vor und zu-
rück, bis es parallel zur Hilfslinie liegt.

C Senken Sie den Einzugshebel wieder ab, um das Mate-
rial festzuklemmen.

Schraube

Messereinheit

0,1mm

Die Messerspitze ist kaum 
sichtbar.

Muss aufliegen
Von unten 
abstützen.

Schraube

Messereinheit

Messer-
vorsprung

Stärke des gela-
denen Materials

Unterlagenstärke= +

2

Messe-

Hälfte der Unter-
lagenstärke

Messer

Unterlage

Material

Der Messervorsprung 
entspricht ungefähr der 
Schneidetiefe.

Einzugshebel

Hilfslinie
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3-3 Über die Schneidedaten
Anlegen von Textdaten

Hier wird erklärt, wie man die Buchstabengröße und 
den Schrifttyp mit Hilfe des “Properties”-Fensters 
einstellt.
CutStudio erlaubt die Verwendung von “True-
Type”- und “OpenType”-Schriften, die auf “True-
Type” basieren.

A Klicken Sie auf [ ].

B Klicken Sie auf die Stelle, an welcher der Text begin-
nen soll.

C Klicken Sie auf [Format]> [Font].

Nun erscheint das “Properties”-Fenster.
Das “Properties”-Fenster kann auch folgenderma-
ßen aufgerufen werden.

• Klicken Sie auf [Format]> [Properties].
• Klicken Sie mit der rechten Maustaste und wählen 

im dann erscheinenden Menü [Properties].

D Ändern Sie die Größe und Schrift des Textes.

[1] Um eine andere Schrift zu wählen, klicken Sie auf [ ] unter 

“Font”. Wählen Sie anschließend den Schrifttyp.
[2] Um die Textgröße zu ändern, klicken Sie auf das [Text Height]-
Feld und geben den gewünschten Wert ein. Die Breite ändert sich 
proportional zum eingegebenen Höhenwert.

E Klicken Sie auf [OK].
Der Text ändert sich nun den Änderungen entspre-
chend.
Weitere Hinweise zu “Properties” finden Sie in der 
Online-Hilfe von “Roland CutStudio”.

F Klicken Sie auf [ ].

G Ziehen Sie einen Rahmen um den Text.
Text sollten Sie prinzipiell mit einem Rahmen umge-
ben, weil er sich dann leichter anbringen lässt.
Wenn Sie besonders kleine Buchstaben ausschnei-
den müssen, empfehlen wir, diese einzeln einzurah-
men, weil Sie sie dann leichter freistellen können.

H Klicken Sie auf [Save].

Nun erscheint das “Save As”-Fenster.

I Wählen Sie mit “Save in” den gewünschten Ordner.

J Geben Sie der Datei einen Namen und klicken Sie auf 
[Save].
Damit sind die erstellten Daten gespeichert.

[2]

[1]

Ziehen
22



Bedienungsanleitung Über die Schneidedaten
Importieren von BMP/JPG-Daten
Mit CutStudio können auch Dateien im BMP/JPG-
Format importiert werden. Die Konturen solcher 
Bilder werden automatisch erkannt und können 
formgerecht ausgeschnitten werden. Dabei sind al-
lerdings nachstehende Hinweise zu beachten, weil 
nicht alle Datentypen importiert werden können. 
Beachten Sie bitte folgende Bedingungen beim Er-
stellen von Bilddaten für CutStudio.

Punkte, die Sie beachten müssen
• Die Farben dürfen nicht ineinander übergehen, son-

dern müssen fein säuberlich getrennt sein.
• Wir empfehlen die Verwendung von Schwarz/Weiß-

Bildern.
• Fotodateien importieren Sie am besten nicht, weil sie 

zu viele Graustufen enthalten.

Wählen Sie die größtmögliche Auflösung
• Der Optimalwert richtet sich nach der Komplexität 

und dem Bildaufbau.
• Hoch auflösende Bilder sind umfangreicher, so dass 

der Import in CutStudio u.U. etwas länger dauert.

A Klicken Sie auf [File] und anschließend auf [Import].

Nun erscheint das “Import”-Fenster.

B Wählen Sie die gewünschte Datei.

C Klicken Sie auf [Open].
Die geladenen Daten werden angezeigt.

D Stellen Sie die Abmessungen und die Position des Ob-
jekts ein.

E Klicken Sie auf [Object]> [Image Outline].

Nun erscheint das “Image Outline”-Fenster.

F Klicken Sie auf [Extract Contour Lines].
Nun werden die Konturen der Bilddatei ermittelt.
Achtung: Die Konturen werden mit Hilfe einer blauen Li-
nie dargestellt.

G Schauen Sie nach, ob die Konturen der Objektform 
entsprechen und klicken Sie auf [OK].
Nun werden die Konturen der Bilddatei ermittelt.

Beispiel einer geeigneten Datei
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Achtung: Mit dem “Object”-Werkzeug können Sie die 
Form des Bildes bei Bedarf ändern. Weitere Hinweise zur 
Verwendung des “Object”-Werkzeugs finden Sie in der 
Online-Hilfe von “Roland CutStudio”.

Entfernen nicht benötigter Objektpartien
Wenn ein Objekt Partien enthält, die Sie nicht brau-
chen, können Sie sie in CutStudio löschen.

A Wählen Sie die Konturen des Objekts.

B Klicken Sie auf [Object]> [Break Polyline].

Damit lösen Sie die Gruppierung auf.

C Klicken Sie auf die zu löschende Objektpartie.

D Klicken Sie auf [Edit]> [Delete].
Das gewählte Teilobjekt wird nun gelöscht. Die übri-
gen Daten bleiben erhalten.

E Wählen Sie die verbleibenden Objektpartien, indem 
Sie die Maus darüber ziehen.

Um den gesamten Inhalt des “CutStudio”-Fensters 
zu wählen, klicken Sie auf [Edit]> [Select All]. Bei 
Bedarf können Sie jedoch auch die [Umschalt]-Taste 
gedrückt halten, während Sie alle Objektpartien an-
klicken.

F Klicken Sie auf [Object]> [Integrate Polylines].

Die einzelnen Konturlinien werden wieder zu einem 
Objekt kombiniert.

‘Object’-
Werkzeug
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3-4 Schneidebereich

Es wird immer etwas Spielraum für den Materialtransport gelassen.

Schneidebreite Schneidelänge Zulässige Materialbreite Zulässige Materiallänge

SV-15 340mm
250mm

1000mm
1000mm

360~381mm
280~305mm

1100mm
1100mm

SV-12 250mm 1000mm 280~305mm 1100mm

SV-8 160mm 1000mm 200~215mm 1100mm

SV-15: SV-12/SV-8:

Andruckrollen

Schneidebreite: 250mm

Zulässige Materialbreite: 280~305mm

Schneidebreite: 340mm

Zulässige Materialbreite: 360~381mm

Schneidebreite:
SV-12: 250mm
SV-8: 160mm

Zulässige Materialbreite:
SV-12: 280~305mm
SV-8: 200~215mm

SchneidebereichSchneidebereich

Messereinheit

MaterialMaterial

Messereinheit

Andruckrollen

Rand: 10mm Rand: 10mm

R
an

d:
 3

0m
m

M
ax

im
al

 1
00

0m
m

M
ax

im
al

 1
00

0m
m

R
an

d:
 3

0m
m
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3-5 Tipps für das Anbringen eines 
größeren Objekts
Je größer der Aufkleber, desto schwieriger wird es, 
ihn waagerecht an der gewünschten Stelle anzubrin-
gen. Außerdem ist es bei größeren Objekten sehr 
wahrscheinlich, dass sich nicht alle Luftblasen ent-
fernen lassen.
Zum Reduzieren der Anzahl der Luftblasen empfeh-
len wir, den Untergrund, auf dem das Objekt ange-
bracht werden soll, mit Wasser und etwas Seifenlau-
ge abzuwischen.

A Stellen Sie das ausgeschnittene Objekt frei und brin-
gen Sie Applikationsfolie an.

B Säubern Sie die Stelle, an der das Objekt angebracht 
werden soll.

Am besten sprühen Sie Wasser mit etwas (2~3 Trop-
fen) Seifenlauge auf die Oberfläche.

C Bringen Sie das Objekt auf der gewünschten Oberflä-
che an und verschieben Sie es so oft, bis es gerade 
hängt.

D Entfernen Sie eventuell verbleibendes Wasser mit ei-
nem Wischer.

E Warten Sie, bis alles Wasser verdampft ist und entfer-
nen Sie anschließend den Applikationsstreifen.
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4-1 Reinigung
Hier wird erklärt, wie man das Gerät reinigt und das 
Messer austauscht.
Achtung: Vor dem Reinigen müssen Sie das Gerät aus-
schalten und das eventuell noch vorhandene Material ent-
fernen.

Säubern des Messers
Achtung: Berühren Sie die Messerspitze niemals mit blo-
ßen Fingern, weil sie ausgesprochen scharf ist. Sonst be-
steht nämlich Verletzungsgefahr.
Wenn an dem Messer noch Materialreste oder Kleb-
stoff hängen, lässt die Schneidequalität sehr schnell 
nach. Entfernen Sie also alle Materialreste.

Säubern der Messereinheit
Achtung: Berühren Sie die Messerspitze niemals mit blo-
ßen Fingern, weil sie ausgesprochen scharf ist. Sonst be-
steht nämlich Verletzungsgefahr.
Wenn die Spitze der Messereinheit noch Materialre-
ste oder Klebstoff aufweist, lässt die Schneidequalität 
ebenfalls zu wünschen übrig.
Schrauben Sie die Kappe der Messereinheit dann ab 
und säubern Sie sie.

Reinigen der Haupteinheit
Das Gehäuse darf nur mit einem trockenen Tuch ab-
gewischt werden. Verwenden Sie niemals Verdünner 
oder Benzin.

4-2 Schmieren des Wagenbügels
Wenn sich auf dem Bügel des Schneidewagens Kleb-
stoff oder Materialreste angesammelt haben, werden 
die Objekte eventuell nicht mehr ordnungsgemäß 
ausgeschnitten. In folgenden Fällen sollten Sie die 
Blende des Wagenbügels entfernen und den Bügel 
folgendermaßen schmieren. Verwenden Sie hierfür 
Maschinenöl.

A Lösen Sie den Netzanschluss.

B Entnehmen Sie die Blende des Wagenbügels.

Verwenden Sie einen Kreuzschlitz-Schraubenzieher 
zum Lösen der Schrauben.

4.  Wartung

Drehen Sie die Kappe in die 
gezeigte Richtung, um sie zu 
entfernen.

Ungleichmäßige Bewegungen

Abnormales Geräusch
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C Befreien Sie den Bügel von Staub und Materialparti-
keln.

D Geben Sie etwas Maschinenöl auf die in der Abbil-
dung gezeigte Bügelpartie.

Achtung: Gehen Sie sparsam mit dem Öl um, weil es sonst 
später eventuell auf das Material tropft.

E Bringen Sie die Blende des Wagenbügels wieder an 
und drehen Sie die zuvor entfernten Schrauben fest.

4-3 Auswechseln von Verbrauchs-
gütern

Auswechseln des Messers
Wenn das Messer stumpf wird und Kerben aufweist, 
müssen Sie es ersetzen. Das ist außerdem notwendig, 
wenn auch mit dem richtigen Messervorsprung kein 
optimales Ergebnis mehr erzielt werden kann. Legen 
Sie ein neues Messer ein.
Entnehmen Sie vorher das Material.
Achtung: Berühren Sie die Messerspitze niemals mit blo-
ßen Fingern, weil sie ausgesprochen scharf ist. Sonst be-
steht nämlich Verletzungsgefahr.

A Lösen Sie den Netzanschluss.

B Lösen Sie die Schraube und entnehmen Sie die Mes-
sereinheit.

C Drücken Sie den Druckstift so weit, bis das Messer aus 
der Einheit gleitet.

Drücken Sie den Stift so weit hinein, bis er nicht 
mehr zu sehen ist.

D Schieben Sie das neue Messer in die Messereinheit, bis 
es hörbar einrastet.

Der Stift springt heraus.

Schraube

Messereinheit

Verschlissenes Messer

Druckstift

Neues Messer
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E Stützen Sie die Schraube ab, während Sie die Mes-
sereinheit wieder einsetzen.

F Drehen Sie die Schraube fest.

Ziehen Sie den Cutter vorsichtig hoch, um zu über-
prüfen, ob er festsitzt.

Auswechseln des Messerschutzes
Kontrollieren Sie den Zustand des Messerschutzes in 
regelmäßigen Zeitabständen. Leichte Kratzer haben 
keinen Einfluss auf die Qualität. Wenn der Messer-
schutz aber stark beschädigt ist, muss er ausgewech-
selt werden. Verwenden Sie hierfür den Reserve-
Messerschutz.
Achtung: Das Messer ist ausgesprochen scharf und stellt 
eine potentielle Gefahr dar. Gehen Sie also mit der gebote-
nen Umsicht vor, um Verletzungen zu vermeiden.

A Lösen Sie den Netzanschluss.

B Entfernen Sie den alten Messerschutz, indem Sie ihn 
mit einem Teppichmesser loslösen.

Am besten verwenden Sie ein handelsübliches Tep-
pichmesser. Beim SV-15 müssen Sie vor Entfernen 
des Messerschutzes die beiden Einzugshebel anhe-
ben.

C Entfernen Sie alle Klebstoffreste vom Gerät.
Verwenden Sie zum Reinigen ein Tuch.

D Schieben Sie den neuen Messerschutz in die dafür 
vorgesehene Aussparung.

E Schieben Sie den Messerschutz bis zur Hilfslinie auf 
dem Gerät.

F Entfernen Sie die Unterlage des beidseitigen Klebe-
streifens und befestigen Sie den Messerschutz am Ge-
rät.

Handelt es sich bei Ihrem Gerät um einen SV-15, so 
müssen Sie nun die Einzugshebel absenken.

Muss aufliegen
Von unten 
abstützen.

Schraube

Messereinheit

Achtung: Halten Sie die andere Hand niemals so, 
dass Sie sich verletzen können, wenn das Teppich-
messer wegrutscht.

Hilfslinie

Einzugshebel
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5-1 Erste Hilfe bei Problemen…
In diesem Abschnitt erfahren Sie, was Sie im Falle ei-
nes Problems tun können. Lesen Sie diese Punkte, 
bevor Sie auf eine Fehlfunktion des Geräts schließen. 
Antworten auf Probleme, die hier nicht erwähnt 
werden, finden Sie wahrscheinlich im “Windows 
Advanced Guide” oder “Macintosh Cutting Guide” 
(elektronische Dokumente). Lesen Sie sie sich bei 
Bedarf ebenfalls durch.

Das Gerät führt die Befehle nicht aus
Haben Sie die Kabel ordnungsgemäß angeschlossen?
Wenn das Netz- oder USB-Kabel nicht ordnungsge-
mäß angeschlossen ist, müssen Sie das korrigieren. 
Siehe “Anschließen der Kabel” auf S. 10.

Stimmen die Treibereinstellungen?
Vielleicht haben Sie den falschen Kommunikations-
port gewählt.

Blinkt die Netzanzeige?
Es ist ein Kommunikations- oder Befehlsfehler auf-
getreten. Schalten Sie das Gerät aus und kontrollie-
ren Sie die Anschlüsse und Treibereinstellungen.

Bei Drücken der [POWER]-Taste wird das Gerät nicht 
ganz ausgeschaltet.
Das ist nur der Fall, wenn Sie den Netzanschluss lö-
sen.

Die Objekte werden verzerrt oder unvollständig 
ausgeschnitten

Ist der Messervorsprung optimal eingestellt?
Korrigieren Sie ihn bei Bedarf. Siehe “Einstellen des 
Messervorsprungs” auf S. 20.

Haben Sie die Messereinheit ordnungsgemäß arretiert?
Drehen Sie die Schraube fest, um zu verhindern, dass 
sie sich während des Betriebs löst.

Ist die Messerspitze abgebrochen?
Legen Sie ein neues Messer ein. Siehe S. 28.

Nicht alle Objekte werden vollständig ausge-
schnitten

Ist die Messerspitze abgebrochen?
Legen Sie ein neues Messer ein. Siehe S. 28.

Ist die Messerspitze eventuell schmutzig?
Säubern Sie das Messer von Schmutzresten. Siehe 
“Säubern des Messers” auf S. 27.

Haben sich Staub oder Materialreste in der Messerein-
heit angesammelt?
Öffnen Sie die Messereinheit und entfernen Sie alle 
Materialreste. Siehe “Säubern der Messereinheit” auf 
S. 27.

Ist der Messerschutz stark verkratzt?
Wenn das Material nicht sauber ausgeschnitten 
wird, obwohl Sie alles ordnungsgemäß eingestellt 
haben, ist wahrscheinlich der Messerschutz beschä-
digt. Installieren Sie einen neuen Messerschutz. Sie-
he S. 29.

Ist die Messereinheit beschädigt oder verschlissen?
Verwenden Sie eine neue Messereinheit.

Der Ursprung verrutscht beim Ausschneiden
Ist der Messervorsprung optimal eingestellt?
Korrigieren Sie ihn bei Bedarf. Siehe “Einstellen des 
Messervorsprungs” auf S. 20.

Wurde der Materialtransport behindert?
Stellen Sie keine Gegenstände vor die Vorder- oder 
Rückseite. Das kann nämlich zu einem ungleichmä-
ßigen Materialtransport und somit zum Verschieben 
des Ursprungs führen.

Der Ursprung verrutscht beim Ausschneiden 
nach links/rechts

Wenn der Ursprung wie nachstehend gezeigt ver-
schoben wird, müssen Sie folgende Punkte überprü-
fen.

Ist der Messervorsprung optimal eingestellt?
Korrigieren Sie ihn bei Bedarf. Siehe “Einstellen des 
Messervorsprungs” auf S. 20.

5. Anhang

Der Abstand zwi-
schen den Buch-
staben ist nicht 
konstant

Die Schneidebahn 
ist seitlich versetzt
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Bewegt sich der Schneidewagen nicht wie gewohnt und 
hören Sie ein ungewöhnliches Geräusch?
Entfernen Sie alle Materialreste und etwaigen 
Schmutz von dem Wagenbügel und schmieren Sie 
ihn. Siehe “Schmieren des Wagenbügels” auf S. 27.

Das Material verrutscht beim Schneiden.
Ist das Material länger als 500mm?
Material, das länger ist als 500mm kann eventuell 
verrutschen. Ziehen Sie es bei Bedarf erneut ein oder 
verwenden Sie kürzeres Material.

Ist das Material zu kurz?
Kurzes und sehr weiches Material kann während ei-
nes Schneidevorgangs verrutschen. Verwenden Sie 
einen anderen Materialtyp oder ein längeres Materi-
alstück.

Laufen die Materialränder parallel zueinander?
Wenn die Materialränder schief sind, müssen Sie sie 
gerade schneiden, damit sie jederzeit parallel zu den 
Hilfslinien laufen.

Wurde der Materialtransport behindert?
Verwenden Sie nur Material mit einer zulässigen 
Breite. Die Materialränder dürfen während des 
Schneidevorgangs auf keinen Fall die Innenflächen 
des Geräts berühren. Das kann nämlich zu Trans-
portfehlern und Schäden am Material führen.

Ist das Material wellig bzw. enthält es Falten?
Das kann zu einem ungleichmäßigen Materialtrans-
port und somit zum Verrutschen des Materials füh-
ren. Entfernen Sie die wellige bzw. verknautschte 
Partie und ziehen Sie das Material erneut ein.

Wenn der Treiber nicht installiert werden kann
Wenn die Installation abgebrochen wurde oder 
wenn bei Anschließen des USB-Kabels kein 
[Assistent]-Fenster erscheint, gehen Sie folgender-
maßen vor.

A Wenn der “Assistent für das Suchen neuer Hardware” 
erscheint, schließen Sie ihn mit einem Klick auf 
[Fertig stellen].

B Rufen Sie die “Systemeigenschaften” auf.

Windows XP

Klicken Sie auf die [Start]-Schaltfläche und anschlie-
ßend mit der rechten Maustaste auf [Arbeitsplatz]. 
Klicken Sie auf [Eigenschaften].

Windows 2000

Klicken Sie mit der rechten Maustaste auf 
[Arbeitsplatz] (auf dem Desktop). Klicken Sie auf 
[Eigenschaften].

C Klicken Sie auf das “Hardware”-Register und an-
schließend auf [Geräte-Manager].

Nun erscheint das “Geräte-Manager”-Fenster. 
Löschen Sie das Symbol des Modellnamens (bzw. 
das “Unbekannte Gerät”).

D Klicken Sie im “Anzeige”-Menü auf [Ausgeblendete 
Geräte anzeigen].

E Suchen Sie den “Drucker”- oder “Andere Geräte”-
Ordner und doppelklicken Sie darauf.

F Klicken Sie auf das Symbol des Modellnamens (bzw. 
das “Unbekannte Gerät”).

G Wählen Sie unter [Aktion] den [Deinstallieren]-Be-
fehl.
Im Display erscheint nun folgende Meldung.

H Klicken Sie auf [OK].

I Schließen Sie das “Geräte-Manager”-Fenster wieder 
und klicken Sie auf [OK].

J Lösen Sie die USB-Verbindung am Computer.

K Starten Sie Windows neu. Siehe dann “Deinstallieren 
des Treibers”.

L Wiederholen Sie die komplette Installation. Siehe 
“Installieren des Treibers” auf S. 11.
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Windows 98 SE/Me

A Siehe “Deinstallieren des Treibers” unten.

B Wiederholen Sie die komplette Installation. Siehe 
“Installieren des Treibers” auf S. 11.

Deinstallieren des Treibers
Zum Deinstallieren des Treibers gehen Sie folgen-
dermaßen vor.
Achtung: Lösen Sie das USB-Kabel an Ihrem Computer, 
bevor Sie mit der Deinstallation beginnen.

A Fahren Sie Windows hoch. Wenn Sie das Programm 
unter Windows 2000/XP installieren, müssen Sie sich 
als “Administrator” anmelden.

B Legen Sie die beiliegende CD-ROM in das Laufwerk 
des Rechners.
Klicken Sie oben rechts auf das [X], um das Fenster 
zu schließen.

C Klicken Sie auf die [Start]-Schaltfläche und dann auf 
[Ausführen].

D Geben Sie den nachfolgenden Text ein und klicken Sie 
anschließend auf [OK].

Windows 2000/XP
(Buchstabe des CD-ROM-Lauf-
werks):\Drivers\WIN2KXP\SETUP.EXE

Windows 98 SE/Me
(Buchstabe des CD-ROM-Lauf-
werks):\Drivers\WIN9X\Setup.exe

E Das “Setup”-Programm wird gestartet und das 
“Driver Setup”-Fenster erscheint.

F Wählen Sie [Uninstall].

G Wählen Sie das verwendete Gerät.

H Klicken Sie auf [Start].

I Klicken Sie auf [Ja], um den Rechner neu zu starten.

In dieser Abbildung heißt das CD-ROM-Lauf-
werk “D”.
32



Bedienungsanleitung Auswechseln von Verbrauchsgütern
5-2 Technische Daten

*Bei Material mit einer Länge von mehr als 500mm besteht die Gefahr, dass es verrutscht und dass die Objekte verzerrt ausgeschnitten werden.
**Bestimmte Materialtypen eignen sich nicht für die Verwendung mit diesem Gerät.

SV-15 SV-12 SV-8

Schneideverfahren Materialtransport

Maximaler Schneidebereich Breite: 340mm
Länge: 1000mm

Breite: 250mm
Länge: 1000mm

Breite: 160mm
Länge: 1000mm

Zulässiges Materialformat (*) Breite: 360~381mm
Länge: Bis zu 1100mm

Breite: 280~305mm
(Länge: A3, Breite: A4)
Länge: Bis zu 1100mm

Breite: 280~305mm
(Länge: A3, Breite: A4)

Länge: 1100mm

Breite: 200~215mm
(Länge: A4)

Länge: Bis zu 1100mm

Schneidegeschwindigkeit 12~100mm/sec 12~40mm/sec 12~40mm/sec

Zulässige Materialtypen (**) Vinylfolie (maximale Stärke: 0,1mm; maximale Stärke inklusive Unterlage: 0,3mm)
Etikettpapier (maximale Stärke inklusive Unterlage: 0,3mm)

Schnittstelle USB 1.1

Stromversorgung Netzteilanschluss: AC100V ±10%, 50/60Hz; 1,7A
Ausgabe: DC 19V, 2.1A

Leistungsaufnahme ±20W (inklusive Netzteil)

Abmessungen (B x T x H) 522 x 205 x 115 mm 440 x 205 x 115 mm 340 x 205 x 115 mm

Gewicht 3,3kg 2,7kg 2,2kg

Geräuschpegel 60dB(A) oder weniger (gemäß ISO7779)

Systemanforderungen Temperatur: 5~40˚C, Luftfeuchtigkeit: 35~80% (ohne Kondensbildung)

Lieferumfang Siehe S. 8.
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